
 

 

 
 

 
 
2 April 2003 No. 14 
 
The Base Bulletin is published each Wednesday (except holidays).  Send proposed bulletin items via email to 
publishing.management.dci@vandenberg.af.mil or to Publishing Management DCI on the Global, or via fax to 
DSN 276-6614 or 805-606-6614 to arrive at 30SCS/SCSP-DCI by noon Friday, the week before you want 
your item to appear.  Be sure to include your name, office symbol, and office phone number.  Remember to 
include your home phone number for personal items.  Your items will run for two consecutive weeks, and 
may be resubmitted one week after the last date it was published.  Bulletins are valid for 90 days unless 
rescinded or superseded.  Note:  If an article requires a 30 SW Form 400, this form must be submitted with 
the article, or it will not be published. 
 
SSEECCTTIIOONN  II  ——  AADDMMIINNIISSTTRRAATTIIVVEE  DDUUTTIIEESS  
Duty Chaplain:  Duty phone, 6-5773.  After hours, 6-9961. 
Safety Hazard:  Dial 5-SAFE (If off base, dial 605-SAFE). 
 
SSEECCTTIIOONN  IIII  ——  OOFFFFIICCIIAALL  
1. Team Vandenberg: 

a. Team Vandenberg Promotion Ceremony:  2 Apr 03, 1500 hrs at the PCC.  All Inductees/Promotees 
must be in place at 1400 hrs.  SSgt inductees will wear Service dress, all others, uniform of the day.  POC:  
30OG/CCF, MSgt Wingett 6-9600. 

b. Operation Salad for Soldiers Honors Military Families:  4 Apr 03, 1200-1900.  Farm-fresh 
vegetables from the fields of Santa Barbara County are being donated to the families of U.S. military 
personnel in an Operation Salad for Soldiers event sponsored by the Santa Barbara County Farm Bureau’s 
Young Farmers and Ranchers Committee and a Santa Maria Packing Firm.  The following will be provided: 
broccoli, cauliflower, lettuce and other vegetables to military families.  Interested personnel may pick up 
these items at the following locations: Santa Maria - Santa Maria Fair Park, 937 S. Thornburg Street, Lompoc 
- Vandenberg Village, 3734 Constellation Road.  POC:  Mr. Teri Bongtrager, (805) 688-7479. 

c. AFOSI Semi-Annual Officer Cross Flow Board:  7 Apr 03 is the deadline to have the applications to 
your local AFOSI Detachment.  Board will convene 1 and 2 May 03.  All Air Force officers are eligible to cross 
flow into AFOSI, provided they have no more than 6 years commissioned service time and 12 years total 
military service time. Before contacting your local Detachment, interested officers must contact their 
assignment team at AFPC to ensure they will be released to AFOSI should they be selected by the board. 
Please contact SA Casey L. Fitzpatrick or SA Andrew D. Schad at 6-1852 for any questions concerning the 
requirements for the package. (AFOSI Det 804) 

d. Titan Gate Hours of Operation:  Due to the closure of El Rancho Road, effective 7 Apr 03 the Titan 
Gate hours of operation will be from 0700 through 1800, Monday through Friday.  Emergency entry and or 
those with mission needs outside of established hours must be coordinated in advance with the 30 Security 
Forces Squadron, Installation Security Section at 5-2585. 

e. Air Force Sergeant's Association, Chapter 1356 General Membership Meeting:  8 Apr 03, 1530 at 
the Services Center, Bldg 10122, corner of Washington Ave and California Blvd.  AFSA membership is open to 
all active duty and retired enlisted military.  AFSA lobbyists continue to inform members of Congress of the 
sacrifices those who wear and have worn the uniform, (and their families) make on a daily basis for the 
protection of the American way-of-life.  From fighting for full pay raises for those still wearing the uniform, to 
full on-time cost of living allowances (COLA) for retirees, AFSA continues to lead the way to preserve and 
improve the quality-of-life for its members.  AFSA Chapter 1356 needs Team Vandenberg's support. POC:     
30 MSG/CCIM, TSgt Astrosky at 6-8700. 

f. Team Vandenberg 2003, 1st Quarter Awards Suspense:  All Company Grade Officer, Enlisted, 
Civilian, and Volunteer packages are due NLT 9 Apr 03, 1630.  Hand carry packages (except Civilian 
Category) to Bldg 10577, Room C-104, 30 SW/JAE, addressed to 30 SW/CGO Board Facilitator, 30 
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SW/Enlisted Board Facilitator, and 30 SW Volunteer Board Facilitator.  Deliver Civilian nomination packages 
to 30 MSS/DPMP, Bldg 11777, Room C-216.  Rules of Engagement/Criteria can be found at the following 
link: http://www.vandenberg.af.mil/awards_promotions/guidance/index.htm POC:  MSgt Chuck Smith, 5-
6207.  (30SW/CCC, 6-9900) 

g. Free Family Portraits for Deploying Members:  9 Apr 03, 1500-1830 by appointment at the Base 
Services Center, corner of Washington and California.  Rollins Photography, a Lompoc professional 
photography studio offers free family portraits to all Vandenberg active duty who are scheduled for 
deployment.  To schedule an appointment please call 6-7976.  POC:  30SW/PA, 6-3595. 

h. American Institute of Aeronautics & Astronautics Luncheon:  16 Apr 03, 1130 at the PCC.  Guest 
speaker will be Colonel (Ret) Mark Lee, fighter pilot and four-time shuttle astronaut.  Lunch menu is as 
follows:  turkey wrap or chicken Caesar salad, cost is $11.  RSVP NLT 11 Apr 03.  POC:  2SLS/MAFB, Lt 
John Morris, (805) 733-1856. 
 
2. 30th Space Communications Squadron: 

a. Emission Security Announcement:  If your have classified processors and have a need to switch 
classified and unclassified signal wire lines or share one monitor, keyboard, and mouse with a classified 
central processing unit (CPU) and an unclassified CPU, an A/B switch can be used.  Contact TSgt Jimenez at 
extension 5-2352 for more information. 

b. Format For Submitting Items To The Base Bulletin:  Please use the following format when 
requesting advertisements to be inserted into the Base Bulletin: 10 point Bookman Old Style font, bold on the 
heading only.  The body of the ad is followed by your name, office symbol and phone number at the end.  
Please provide us with your advertisement in time to run for no more than two weeks prior to the event.  
Submissions desired COB on Friday for the following weeks edition.  Absolute deadline is 0900 Tuesday if 
there is no holiday that week.  Requests for volunteers, award packages, and scholarships needing more lead-
time can be sent sooner.  Please write your text as a paragraph rather than a list when sending us your ad.  
Your cooperation in this matter would be greatly appreciated.  POC:  Publishing Management, 30SCS/SCSP-
DCI, 6-7892/7894 

c. Change Forms/Office Symbols:  Effective 1 Oct 02 a major reorganization transpired.  As a result, 
several organizations now have new office symbols assigned.  Please ensure that these changes are 
incorporated into organizational documents prior to submitting to the Publishing Management Office for 
review.  In particular, the new IMT forms will be updated with the new office symbol that you provide.  Your 
cooperation in this matter is greatly appreciated.  POC:  Publishing Management, 30SCS/SCSP-DCI,            
6-7892/7894. 

 
3. Traffic Management Office: 

a. Separating, Retiring or PCSing?  PLAN AHEAD!  Within 30 days of receipt of orders, stop by TMO, 
Bldg 11777, Rm C-103 to schedule an appointment for your household goods pick up dates.  Remember, the 
earlier your meet with us, the greater your chances of moving on the date you initially select.  As always, we 
will work with you to the greatest extent possible.  POC:  SSgt Papa, ext 6-0904 (30LRS/LGRT) 

b. It’s Your Move:  If you are scheduled to make a Government sponsored move this message is for you.  
The Traffic Management Office (TMO) would like to send you information to assist you with your move.  Along 
with the briefings, an “E” package of tips and information on you upcoming move can be emailed to your 
computer.  POC:  Maureen Burt, 6-6932/33 (30LRS/LGRT) 
 
4. Civilian Personnel:  (30MSS/DPCE, 6-5847) 

a. Voluntary Leave Transfer Program:  Doris Vogel and Jeannette H. Parker, Vandenberg AFB, 
Anonymous (employee does not wish to be identified), Tyndall AFB, Janet Brown, Ethel Carter, and Sue 
Sommers, Scott AFB, Denise Christopher, Luke AFB, Debra Bucheck, Kevin Hanson, Anthony Karas, and 
Gail Knitter, General Mitchell IAP WI, Lora Hudson, Kirtland AFB, Jane Kelsey, Eglin AFB, Jeff Moody, 
Patrick AFB, Jacquelyn Schmidt, AF Academy, Mary Shepherd, Robins AFB, and Michael Zarbo, Ramstein AB 
are in need of leave donations.  Civilian employees who would like to donate a portion of their annual leave 
must complete an Optional Form 630-A.  You can go by Building 11777, Room B-105 to pick-up and/or turn 
in your form.  You can access this form on the web at: 
http://www.opm.gov/FORMS/PDF_FILL/opm630A.pdf. 

b. Weingarten Right:  Federal civilian employees who are members of a bargaining unit have the 
qualified right to union representation during investigatory interviews/meetings.  This Weingarten right is 
mandatory when the following four (4) conditions are met: 

    1.The meeting between the employee and management official(s) must be an examination, 

http://www.vandenberg.af.mil/awards_promotions/guidance/index.htm
http://www.opm.gov/FORMS/PDF_FILL/opm630A.pdf.
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    2.  The examination must be in connection with an investigation, 
    3.  The employee must reasonably believe that disciplinary action may result from the meeting; and 
    4.  The employee must request representation. 

 
5. Security Forces Squadron:  (30SFS/SFTC, 5-5025) 

a. Neighborhood Watch Program:  This program is run by you and designed to help ensure a safe and 
secure neighborhood.  If you are interested in starting this program in your area, call 5-0792.            
(30SFS/SFOSP) 

b. Vacation Quarters Check:  If you live in base housing and plan to take leave or go TDY, have 
Security Forces check your home while you are gone.  To make arrangements, stop by the Security Forces 
Dispatch Bldg. 13730.  For more information, call 6-3911 or 5-0792  (30SFS/SFOR) 
 
6. Air Force Reserve: 

Briefing:  8 Apr 03, 1300, Bldg. 11777, Room C-114. If you are interested in applying for this program, 
you must first attend the Palace Chase briefing.  For more information, call MSgt Kartheiser.  (AF Reserve 
Recruiter, 30MSS/ISR, 6-2704) 
 
 
 
 
OFFICIAL   Robert M. Worley II 
   Colonel, USAF 
   Commander 
 
 
 
Mary E. Meyer 
Chief, Publishing Management 
 
 
SSEECCTTIIOONN  IIIIII  ——  UUNNOOFFFFIICCIIAALL  

a. 

b. 

General Information: 
Discounted Petroleum Products:  With the rising prices of petroleum-based products on the local 

economy, HAZMART still maintains many petroleum products at discounted rates.  POC:  30LRS/LGDMH,     
Ed Conway, 6-8621 or 6-3400. 

Kindergarten Registration at Crestview Elementary:  2 April 03, in the Multipurpose Room at 
Crestview Elementary.  Registration Procedures:  Last names beginning with A through M is from 0815-1045 
hrs and N through Z" is from 1300-1430 hrs.  You must bring:  1.  Your child.  2.  Child's birth certificate or 
passport to verify his or her age.  3.  Immunization record.  4.  Child's social security card.  Services Provided:  
Vision and hearing screenings.  Registration Time Line:  45 minutes to 1 hour.  Request:  Please arrive one 
hour before the close of registration.  Restrictions:  Child must be 5 on or before 2 Dec 03.  POC:  Janet or 
Jeri at        734-2896. 
c. Aqualliers Dive Club Meeting:  2 April 03, 1800-2000 hours at Cabrillo High School Aquarium.  Topics  
of this meeting will be the Cabrillo Aquarium and April Earth Day Camp Out at Refugio State Beach.  POC: 
Roy Wurzbach, 733-5026.  Our Club website: http://members.tripod.com/aqualliers/aqualliers.html. 
d. The Lompoc Community Concert Association's 55th year of concerts:  4 Apr 03, 1730 at the Trinity 
Church of the Nazarene, 500 E. North St, Lompoc.  The feature will be Opera, Broadway & Beyond.  A blend 
of the Power, Passion & Pizzazz of Opera, Broadway, & Pop's best with the hilarious and poignant 
recollections of one artist's journey in life and art.  Ticket Cost is as follows: $10 for adults and $5 for 
students.  Presence at this concert will also entitle the purchaser to attend the bonus concert by Miwa 
Gofuku (pianist) and Scott Reed (Tenor) on 9 May 03.  POC:  Molly Blaschke at 733-2125 or Jean Jacoby at 
736-8713. 
e. On Base Motorcycle Club Monthly Meeting:  4 Apr 03, 1500.  Meetings are held the First Friday of 
every month at the Services Center, across from the Fitness Center.  Monthly rides are on the second 
Saturday and third Sunday of each month, meeting point will be at the Main Gate at 0900.  All Motorcycles 
welcome!  POC:  30SFS/SFMT, SSgt Sherri L. Jones at 5-0751. 

http://members.tripod.com/aqualliers/aqualliers.html.
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f. 30CES Activities Council Cuisine Luncheon:  16 Apr 03, 1100-1300 at the Bowling Alley Parking Lot.  
Menu: Beef & Broccoli, Teriyaki Chicken, Fried Rice, soda or water.  Cost is $6. POC:   30CES/CEOEI, Sony 
Apilado at 6-1936, SSgt Karon Williams 5-3544 or TSgt Lisa Mitchell 6-8057. 
g. Commissary Photo Contest:  17 Apr 03.  Enter your favorite baby picture for your chance to win a $25 
shopping spree.  Entries will be accepted up to and including the day of the contest at our Customer Service 
Office.  POC:  Paige Zuniga, DECA, 734-3354, ext. 235. 
h. Commissary Children’s Appreciation Day:  18 Apr 03, 1700.  There will be fun, food and games for the 
whole family.  POC:  Paige Zuniga, DECA, 734-3354, ext. 235. 
 
Health and Wellness Center:  (To Pre-Register for classes call 6-2221) 
a. 
b. 
c. 

d. 

e. 

f. 

g. 

Tobacco Cessation Classes:  6-week program that includes medication. 
Sensible Weigh:  4-week weight/fitness class.  Call for schedule and to sign up. 
Risk Reduction Classes:  Weekly classes meeting at the MDG, which address Cholesterol, Diabetes, 

Hypertension and Weight.  Topic varies call for schedule and to sign up. 
Prenatal Exercise Class:  Quarterly class.  Next class 22 May 03, 1400. 

 
Chapel:  (30SW/HC, 65773) 
a. New Chapel Hours:  The Chapel is open from 0700-2100 seven days a week and a Chaplain will also be 
available during this time.  Any questions, please call 6-5773. 
b. Worship Schedule:  Catholic Mass: Sat, 1700 Chapel II; Sun 1000, Chapel I, Daily Mass: 1130 M-F, 
Chapel II.  Protestant, Praise & Worship: 0830 Sun, Chapel II; Gospel 1130 Sun, Chapel II; Traditional 1130 
Sun, Chapel I. 
c. Daily Prayer:  Every morning from 0715-0725 and evenings 200-2010 at Chapel I.  All Vandenberg is 
invited to pray for our Nation, our Troops & Families. 

Upcoming Lent Devotions:  2, and 9 Apr 03.  Protestant Lent Devotions will be held on these 
Wednesday’s at 1130 Chapel 1.  Catholic Mass at 1130 at Chapel 2.  Then both groups will meet at PCC at 
1200 for soup and bread. 

Stations of the Cross:  4, 11, 17 Apr 03, 1700-1900 at Chapel I.  Afterwards please come and join us for 
soup and bread at the Chapel 1 Annex.  

G.I Java:  Need a shot of Caffeine!  All dorm and Billeting residents are invited to come and enjoy FREE 
lattes, frappicinos, sodas, chips, and fellowship at a world-class CYBERNET CAFÉ!!  Open 7 days a week, 
1700-2100.  Located in the Delta Dayroom across the street from Breakers Dinning Facility.  For further 
information, contact SSgt Jennifer Wilkins or Chaplain Mike Martin at 6-5773. 
h. Easter Egg Hunt:  13 Apr 03, 1400-1600 at the Religious Education Complex.  All children from toddler 
to age 12 must be registered to participate in the Chapel-wide Egg Hunt.  Donations of plastic eggs, Polaroid 
film, and lots of wrapped candy are still needed. To register call the Chapel Office at 6-5773. 
 
Family Support Center:  (To pre-register for all classes, workshops, and seminars, call the designated point 
of contact.) 
a. Office Closure:  The Family Support Center will be closed for staff training every Monday from 0730-
0930.  Personnel requiring emergency Air Force Aid will be assisted.  POC:  Sally Galligan, 30 MSS/DPF, 6-
0801. 
b. Pre-Separation Briefing:  Required 90-120 days prior to leaving the service for military members 
scheduled to retire or separate.  This mandatory counseling session consists of service member benefits.  
Spouses are welcome and encouraged to attend.  This session is offered every Tuesday morning, 0800-0900 
(except TAP seminar week).  Call 5-0134 for more information. 
c. Investment Planning:  4 Apr 03, 1100-1200 at the Family Support Center.  Should you start investing?  
If yes, what kind of investment should you be looking into?  Learn what the Thrift Savings Plan, IRA’s, Bonds, 
and more mean to you and where to begin.  Get lots of information on enrollment, investment vehicles, and 
more.  Call Jimmy Camacho at 6-4491. 
d. 3-Day TAP Seminar:  8 through 10 Apr 03, 0800-1600 at the Family Support Center.  This is a highly 
recommended seminar for those who are scheduled to be separated or retired from the military service within 
one-year.  Speakers brief you on job search, networking, resume writing, interview technique, federal 
employment opportunity, relocation, education and vocational opportunities, and other topics.  Sign up early!  
Contact Larry Davis at 5-0134. 
e. Single Parents Support Group:  8 Apr 03.  Meets the second and fourth Tuesday every month, 1130 to 
1300 at the Services Center.  This is an opportunity for single parents to meet other single parents as well as 
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discuss any stressors with their responsibilities at home or at work.  Contact Linda Bastine at 6-9958.  No 
registration is required. 
f. Separation, Retirements and Stop Loss Effect:  Now that Stop Loss is in full swing and you are 
wondering about your future, we are here to help.  The Family Support Center, Bldg. 10525 is still conducting 
the mandatory Pre-separation Briefing and the Transition Assistance Program (TAP) Seminar.  Don’t let Stop 
Loss hold you up from continuing your future plans.  We are here to help and want you to be ready when 
Stop Loss is lifted.  Don’t wait until the last minute, visit your FSC or call Mr. Larry Davis at 5-0134. 
g. Volunteers Needed:  If you are looking for a rewarding way to help our military community, meet other 
people, and learn about the Base and local area, then consider volunteering at Family Services.  Just a few 
hours a week can make a real difference in the lives of our military families.  Free childcare for up to 15 
hours/month is available for our volunteers.  Call 6-5484 or 6-0039 for more information. 
 
30th Services Squadron:  (30SVS/SVK, 6-0276) 
a. Pacific Coast Club:  (For information on any Club functions, please call 734-4375 or 734-4376). 

$ Club Card Drawing:  The drawing is every Friday between 1700 and 2000.  $50 giveaway in each 
lounge each week.  Must be present to win. 
Entertainment/Events: 
z Latino Night:  4 Apr 03, 2100-0200, in the Enlisted Lounge. 
z Karaoke & DJ:  4 Apr 03, 1800-2200, in the Officers' Lounge. 
z Mug Night:  5 Apr 03, 2100-0200, in the Enlisted Lounge. 
z Kids Night:  10 Apr 03, 1700-2000, in the dining room. 
Menu: 
z April Special:  Get a dozen hot wings for just $3.95 with purchase of 1 large pizza of your choice. 
z Pasta Mania Buffet:  Thursday Nights, 1700-2000.  
z Weekly Lunch Schedule:  Tuesdays-Mexican, Italian, or Oriental Buffet (on a rotating schedule), 

Wednesdays-Santa Maria BBQ Buffet, Thursdays-Chicken and Ribs Buffet, and Fridays-Seafood 
Buffet. 

b. Fitness Center:  (30SVS/SVMP, 6-3832) 
z Boxing Training: Mon-Fri, 1800-2000. Free Boxing training is available at the Boxing Annex (Bldg 

14019). 
z Dumbbells for Beginners:  9 Apr 03, 1800. 
z Fun Run In Spring:  11 Apr 03, 1200. 
z Basketball Camp Volunteers:  Women volunteers and basketball players are needed to form teams to 

scrimmage against the Air Force Women's Basketball Camp players.  Camp runs through 10 Apr 03. 
c. Bowling Center:  (30SVS/SVRB, 6-3209/734-1310) 
z Airmen's Night:  3 Apr 03, 1700-2100.  Every Thursday night at the Bowling Center, E-4's and under 

bowl for just $1 per game. 
z Deployed Spouses Day:  Starting 1 Apr 03.  Deployed spouses can play for just $1 per game every 

Tuesday from 0900-1200.  All pre-school age children bowl for free with a paying parent.  
d. Youth Center:  (30SVS/SVYY, 6-2152) 
z Youth Softball:  Vandenberg Youth softball is currently looking for young ladies age 11-14 to fill the 

league teams.  Registration will continue until teams are full. 
z Easter egg Hunt:  12 Apr 03, 1000 sharp.  Annual Easter Egg Hunt to be held at the Youth Center.  

The hunt will begin at 10:00AM sharp!  Bring your own basket and your camera to get a picture with 
the Easter Bunny.  Don't be late!!!  For more information call 6-2152. Hunt is for ages 2-10 

z Summer Camp:  1 through 18 Apr 03.  Summer camp Priority registration for those currently enrolled 
in the school age program.  Registration for all others starts 21 Apr 03 and ends 16 May 03.  Please 
contact the youth center for more information. 

e. Marshallia Ranch Golf Course:  (30SVS/SVRG, 6-6262) 
z Course Aerification:  31 Mar 03 through 4 Apr 03.  Marshallia Ranch will be aerifying the greens, 

tees and fairways.  Twilight rates will be in effect during this time. 
z Spring Open:  12-13 Apr 03.  Cost is $20, sign up at the Pro Shop by 10 Apr 03. 
z Youth Golf Lessons:  Saturdays at 1330 at Marshallia Ranch Golf Course Youth golf lessons are 

available for ages 8 years and up.  Cost is $5 each session, includes use of rental club set and range 
balls. 

f. Services Center:  (30SVS/SVYR, 6-7976) 
z Free Dance Lessons:  Wednesdays, 1830-2100.  Free country-western line dancing lessons. 
z Discovery Dining: Discovery Dining Books are now available for just $15 at the Services Center. 
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z Natural Knead Massage:  Gift baskets and gift certificates are available. 
z Performing Arts Club:  The Services Center is looking for people interested in starting up a 

performing arts club.  This club will involve theater production, acting, singing, dancing and will also 
put on shows at the Services Center. 

g. Child Development Center:  (30SVS/SVYC, 6-1555) 
z Give Parents a Break:  This program offers parents one evening of childcare per month for parents 

who need a break.  Give us a call and find out if you qualify. 
h. Outdoor Recreation/Equipment Checkout:  (30SVS/SVRO, 6-5908) 
z Rafting Guide Training:  Outdoor Rec is looking for volunteer guides for the upcoming rafting season. 

A training course will be available 12-16 May 03.  Cost is $100.  Must be 18 or older and is good 
physical condition.  Call Curtis at 606-5908 for details. 

z Deep Sea Fishing:  12 Apr 03.  Port Hueneme Sport fishing.  Leave VAFB at 0100, return at 1900.  
Cost is $65. 

i. Library:  (30SVS/SVMG, 6-4202) 
z Pre-School Story Time:  Every Thursday at 1000. 
z Dial-a-Story:  This week:  The Princess and the Pea.  The phone number is 6-4300 (Available 24/7). 
z Professional Reading Group:  11 Apr 03, 1500.  Sponsored by the CGOC, this new group would like 

to read and discuss professional reading materials.  For more information about reading groups at the 
library, contact Dixie at 6-6050. 

j. Skills Development:  (30SVS/SVRS, 6-6438) 
z Classes & Workshops:  Woodworking, Ceramics, Stained Glass, Framing, and Auto Skills classes are 

available.  Stop by for a complete schedule. 
k. Information, Tickets & Travel:  (30SVS/SVYR, 6-7976) 
z Monterey For a Day:  13 Apr 03.  Cost is $35 per person.  Visit the Aquarium (we have discounted 

tickets), shop at the Cannery Outlet Mall or just enjoy the ambiance of this beautiful city. 
z Getty Museum: 26 Apr 03.  Cost is $35, transportation and reserved entrance time. 
z Yosemite:  28-30 Apr 03.  Cost is $225 per person sharing, single, $345.  Two nights at the Yosemite 

Lodge, located at the valley floor.  Free shuttles are available all day to all the sightseeing and hiking 
areas in the valley. 

l. Breakers Dining:  (30SVS/SVMF, 6-7540) 
z Extended Dining:  Breakers has extended the Saturday dinner hours to 1600-1900 on a trial basis. 

These hours will run through 31 May 03. 
z Deployed Spouses:  Thursdays, starting at 1800.  Open to all spouses and dependents of deployed 

members.  This offers spouses a chance every week to socialize with other spouses and gives them a 
break from cooking.  E-4 and below pay cost of food only, E5 and above include surcharge.  

m. Rod & Gun:  (30SVS/SVRR, 6-4560) 
z Open Shoot:  Open Trap & Skeet shoot every Wed, Fri and Sat morning at 0830. 
z Intramurals:  Starting in April. See your sports unit rep for details. 
z Sporting Clays:  2nd and 4th Sundays each month. 
 

Computer Training:  (MCA, 6-3771) 
a. Personal Computer Systems Training:  Call for information and dates for our new classes, Adobe 
Acrobat Writer, Photoshop Elements, and Advanced Access.  Learn Introduction to Computers -- A basic 
classes for beginners; Word 2000; Word Advanced; Excel 2000; Excel Advanced; PowerPoint 2000; Access 
2000 Beginning; Access 2000 Intermediate; Access Lab, Palm PDA Beginning, and Project 2000; Publisher 
2000, Front Page 2000, Outlook, and Outlook Email Only.  In addition to the existing traditional 
demonstration/lecture courses offered at the Computer Training Facility located within Bldg. 9360, MCA 
Engineers, Inc. also reserves 4 hour blocks of time specifically for those students interested in completing 
Computer Based Training (CBT) Courseware.  This provides an alternate method for those who are unable to 
satisfactorily complete CBT's at their Personal Computer in their work environment.  Slots are available both 
in the morning and afternoon time frame.  Call 6-3771 for more information, or e-mail: lexi.schwartz 
@vandenberg.af.mil. 
b. Computer Tip:  Do you want to place an image of an Excel file into a Word document, image editing 
program, or other program? It's easy to do.  On the Excel worksheet or chart sheet, select the cells or click 
the chart or object you want to copy.  Hold down SHIFT and click "Copy Picture" on the Edit menu.  For best 
picture quality, make sure "As shown on screen" and "Picture" are selected, and then click OK.  Switch over 
to the worksheet or other document where you want to paste the picture.  Click "Paste" on the Edit menu.  To 
make adjustments to the image after you've pasted it, use the Picture toolbar. (To open it, point to Toolbars 

mailto:lexi.schwartz@vandenberg.af.mil
mailto:lexi.schwartz@vandenberg.af.mil
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on the View menu and click Picture.)  Note: Cell gridlines appear in the picture if they are displayed. To omit 
gridlines, in Excel click "Options" on the Tools menu, click the View tab, and then clear the Gridlines check 
box. POC Lexi Schwartz 6-3771 
c. Available Classes:  The following classes currently have room and are available on a "first come-first 
serve" basis.  Email us to register for classes you would like to attend. 

Course Name Date(s) Time 
Outlook 4/1-3 08:00-11:00 
Photo-Special Effects 4-2 11:30-12:30 
Acrobat Writer Basics 4/3-4 13:00-16:00 
FormFlow 4-4 08:00-11:00 
Excel-Macros 4-4 11:30-12:30 
Photo Shop Elements 4/7-11 13:00-16:00 
Photo-Selecting What You Want 4-7 11:30-12:30 
Outlook Email Only 4-7 08:00-11:00 
Intro to Computers 4-8 08:00-11:00 
Word 2000 4-9 08:00-11:00 
UCM Training 4-9 08:00-11:30 
Outlook-Calendaring 4-9 11:30-12:30 
Acrobat Reader 4-11 11:30-12:30 

Note:  Walk-ins are always welcomed! 
 
American Red Cross: 
Lompoc Valley District Office 
312 H Street, Lompoc (805) 736-5110 
Email us:  disaster@sbaco-redcross.org. 
Training Courses Date Time 
Introduction to Disaster Services #3066  
& Orientation to Red Cross 

Introduces participants to the American Red Cross and 
Disaster Services. Provides basic information about 
disasters & their effects and how the Red Cross 
assists. 

 
6 May 03 

 
1800-2100 

Mass Care Overview  #3068-1 
Overview of immediate Mass Care services on chapter 
administered disaster relief operations, as well as on 
larger relief operations. 

 
8May 03 
 
 

 
1800-2100 

Damage Assessment # 3067 

Prepares participants to conduct the damage 
assessment that is used as the basis for Red Cross 
family assistance. Covers the kinds of damage to be 
assessed, how to document damage & submit reports.    

 
13 May 03 

 
1800-2100 

ERV Ready, Set, Roll! #4002 

Prepares participants to drive the Emergency Response 
Vehicle and its function during a disaster. 

 
17 May 03 

 
0900-1500 

Shelter Operations # 3068-11 

Part 1 of a two-part class that teaches participants to 
open, maintains, and to close a shelter. Includes 
management of equipment and supplies, space 
allocation, & problem solving.  

 
20 May 03 

 
1800-2100 

Shelter Simulation #3068-12 

Part 2 teaches participants to open, maintains, and to 
close a shelter. The simulation is a tabletop exercise 
conducted under the guidance of the instructor. 

 
22 May 03 

 
1800-2100 
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Providing Emergency Assistance to Families  #3072 

Prepares participants to interview and provide 
standardized financial assistance to victims of smaller, 
chapter based disasters & larger, nationally 
administered disaster operations. 

 
24 May 03 
 

 
0900-1700 

Disaster Action Team (DAT) Workshop #4001 and 
DAT Team Meeting 

Prepares participants to serve on the chapter Disaster 
Action Team that respond to local residential disasters 
and provide assistance to those who are displaced. 

 

 
27 May 03 

 
1800-2030 
 

 
Items For Sale or Free To A Good Home: 
Free To A Good Home:  4 yr old black lab mix, spayed female.  Housebroken, does not chew, very friendly 
and good with children.  Shots up to date.  PCSing and need to find her a good home.  If interested please call        
734-2124. 
Free to a Good Home:  Two cats and all accessories.  Housebroken and loving.  Moving and must give up.  If 
interested call 734-3660. 
For Sale:  Boy’s 15-Speed Bike,$20, Girl’s 10-Speed Bike,$10, Barbie Doll House,$15.  If interested please 
call 734-1044. 
For Sale:  2000 Mitsubishi Montero Sport XLS, 3.0 liter V-6, automatic, 2-wheel drive, 39,000 miles, AC, 
power steering, power windows, power door locks, tilt wheel, cruise control, AM/FM stereo, single compact 
disc, dual front airbags, ABS (4-wheel), leather interior, sliding sun roof, roof rack, privacy glass, running 
boards, two-tone paint, alloy wheels.  One owner, have all routine maintenance records, garaged and in 
excellent condition.  Asking $17,900, call Doug at 734-3060. 
For Sale:  New Olympic Weight set, includes 45Lb bar, 2ea plates (2 1/2, 5, 10, 35, 45Lbs) totaling 245LBS.  
Also includes a used bench.  A $300 dollar value!  Take all for only $150. 
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